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Introduction
Tecplot Chorus provides a robust framework for managing CFD projects, such as parametric studies,
that require multiple simulation cases with tools to evaluate the results. You can evaluate overall
system performance and visually compare tens or thousands of simulation cases in a single
environment, helping you make decisions faster and with more confidence than ever before.

Before You Start the Tutorials
Before beginning a tutorial from this guide, we suggest you read through Chapters 1 and 2 of the
User’s Manual to introduce yourself to the Tecplot Chorus user interface and familiarize yourself with
the product’s basic concepts of operation. It may be helpful to have Tecplot Chorus open while reading
these chapters so you can experiment a little.

Chapter 1 - Introduction

Covers the Tecplot Chorus workspace, the menu bar and global toolbar, context menus and
toolbars, and sidebars. Reading this chapter will orient you to the main user interface controls of
Tecplot Chorus, making it easier to find what you’re looking for when you are working on the
tutorial.

Chapter 2 - Projects

Covers the Welcome Screen, Project basics, variable properties, and directory management. You will
get practice with many of these concepts in the pages that follow. You may want to review Chapter 2
again after completing the tutorial.

Tutorials In This Guide
This Getting Started Guide is divided into tutorials, each of which contains one or more exercises
covering various aspects of the topic at hand. In general, you should go through them in order, as the
early tutorials tend to explain concepts in more detail than later ones. However, once you have some
familiarity with Tecplot Chorus and Tecplot 360 EX, you can skip around if you like.

The tutorials are:

A Virtual Tour

Uses a data set included with Tecplot Chorus to explore its various features. A good overview of the
most-used Tecplot Chorus features.

SO2 Plume Migration Study

Uses an industrial CFD simulation involving sulfur dioxide concentrations as an introduction to
how you might use Tecplot Chorus in the real world.

Electronic Actuator Optimization

An optimization study involving the design of an electronic actuator used in aircraft. Shows you
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how to use constraint visualization to help you find the "sweet spot" in your design space.

All of the datasets can be downloaded in the Chorus Getting Started Bundle.

Dive in and master the view!

A Virtual Tour
Tecplot Chorus provides a robust framework for managing CFD projects, such as parametric studies,
that require multiple simulation cases with tools to evaluate the results. You can evaluate overall
system performance and visually compare tens or thousands of simulation cases in a single
environment, helping you make decisions faster and with more confidence than ever before.

This tutorial will take you on a tour of Tecplot Chorus’s most important visualization features,
including:

• Opening a project

• The project views available in Tecplot Chorus

• Viewing images and data associated with cases in a project

What you should be doing during this tour is playing with the features as we introduce them. We’ll tell
you what they do and what they’re for, but getting your hands on the product is the best way to
become familiar with how it feels to work with it. You’ll be working only with sample data that’s
included with your copy of Tecplot Chorus, so don’t worry about messing up or erasing anything. The
data can also be downloaded in the Chorus Getting Started Bundle.

Opening a Project
We’ll open an example project included with Tecplot Chorus. The example projects are stored in the
sampledata folder in your Tecplot Chorus installation.

1. Start Tecplot Chorus. The Welcome Screen appears.
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The Welcome Screen on a fresh install of Tecplot Chorus lists the example projects under Recent
Projects. If "Example 1" is listed, simply click it to open the project and skip the next step. If
Example 1 is not listed, continue with the next step.

2. Choose File → Open Project., navigate to the sampledata folder inside your Tecplot Chorus
installation folder, and open the file example1.chprj.

The project only takes a second to open; then the Tecplot Chorus Welcome Screen disappears and a
Table View of the project appears.
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Other views can be opened using the View menu or buttons on the toolbar. Don’t open anything
yet, though; we’ll get to that soon enough.



What’s in a project?

Each simulation you run with a different combination of input parameters (or
independent variables) results in its own record in Tecplot Chorus, referred to as a
case.

For each case, Tecplot Chorus keeps track of the simulation’s inputs (independent
variables) and outputs (dependent variables) along with optional informational fields
you provide and any associated image or data files. Since these pieces of information
are "data about data" (where the solution files generated by the simulation are the
actual data), they are sometimes collectively referred to as metadata.

For now, let’s just look at an existing project and see how it’s laid out.
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Exploring the Table View
The Table View appears immediately when you open a project. You may also open a Table View at any

time by clicking on the toolbar or by choosing View → New Table View. Here it is again (this time
without the other parts of the Chorus workspace to distract you).

The Table View is the least interesting view from a visual standpoint, but it is incredibly useful for
looking at the project’s actual numbers. And of course, it’s already open, since we just opened the
project, so it’s where we’ll start.

Each row in a Table View represents a single case associated with a unique combination of input
values. Poke around a bit and you can see that:

• Each case is represented as a row, and the values associated with it are represented as columns.
Each case has the same set of variables.

• Tecplot Chorus assigns each case a numeric Case ID. The first Case ID is 1, and each new case
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imported is assigned the next number higher. This can be useful shorthand when discussing a
particular case with others.

• We can easily tell that there are 191 cases in the project, because the highest Case ID is 191. (Scroll
down to the bottom to see.)

• Besides the Case ID, there are seven additional columns, labeled "Mach No.," "Alpha," "Beta," "#
Iterations," "Lift Coef.," "Drag Coef", and "Pitch Mom. Coef." You may need to scroll right to see all of
them. Each column represents a variable.

Aerospace engineers will recognize the first three as common independent variables (inputs to a
simulation) and the others as likely dependent variables (outputs from the simulation).

• There are subtle tick marks at the top of each cell. These indicate where each cell’s value falls
within the range of the variable in the project, with the left edge representing the minimum value
of the variable and the right edge representing the maximum. As you scroll down in the table, then,
the tick mark in the Case ID cells moves predictably from left to right. Check out how it moves in
other columns, which are not necessarily in order.

• If you’ve been playing with the filters, you may see shading in some columns, or some of the values
being displayed in red rather than in black, to help visualize the effects of the filters. The shading
represents the proportion of low and high values being filtered out. A value is colored red if it
violates the column’s filter.

It is also possible for a project to include variables that are informational in nature, rather than being
inputs or outputs. These might record the date, the identity of the engineer who ran the simulation,
what cluster it ran on, and similar housekeeping information. This example project doesn’t have any
such variables.

It’s also possible to append additional cases and variables to a project, and also to calculate variables
within Tecplot Chorus. (See Chapter 2 in the Tecplot Chorus User’s Manual for more details.)

You can sort the table in ascending order on a variable by clicking a column header. Clicking the same
header a second time sorts in descending order. This makes it easy to determine the range of any
variable in the project. Try it out!

 There’s a view similar to the Table View that shows only the selected cases. You can
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show it by choosing Selected Cases from the View menu. It’s particularly useful for
seeing the values of cases you’ve selected in other views.

Exploring the Matrix View
The Matrix View lets you visually sift through the cases in your project using image thumbnails
associated with some or all of the cases in the project. Rows, columns, and optionally pages can be
assigned to represent any variable in the project.

To open a new Matrix View, choose View → New Matrix View, or click  in the toolbar. The
Matrix View appears next to or partially on top of the initial Table View, depending on how much room
is available in the Tecplot Chorus workspace.



Managing Windows

Each time you click a toolbar button to open a view or plot, Tecplot Chorus opens a
new view or plot of that type, even if you already have one open. Tecplot Chorus tries
to position the new window so that you can see at least parts of some of your other
windows, but there isn’t always room.

If, when you open a window, that plot covers an existing window, the existing window
is still there, but hidden. Don’t worry that you have "lost" a plot you have
painstakingly set up when you open a new one; the old plot’s still there behind the
new one.

Click the  button in the toolbar to display all open windows in a grid, making it
easier to find the one you want.

In our initial view (yours may be different depending on how you’ve sized the Tecplot Chorus
window), only a few image thumbnails are visible.

9



If your screen is small, you might want to maximize the window so it uses all of the workspace, then
use the Zoom slider in the lower right corner of the window to make the thumbnails as small as
possible, so you can see more of the cells in the Matrix View. You should be able to fit most or all of
them in, like this:
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At this point, you can see:

• Some cells in the matrix are blank. In the example project, some of these are missing
cases—simulations that haven’t been run. Real projects will often be even more sparse.

Another reason a matrix cell might be blank is that none of the cases that belong in that cell have
an image associated with them. This isn’t the situation in the example project, however.

• Tecplot Chorus has assigned the variables Mach No. and Alpha to the rows and columns of the
matrix, respectively. You can change these variables.

• Each discrete value of each variable gets its own row or column.

Try clicking on some cases. If you can still see the Table View you already opened, you will notice that
when you click a cell in the Matrix View, the corresponding row in the Table View, if it happens to be
visible, is highlighted. In Tecplot Chorus, selecting a case in one view selects it in all views. You can
open a special, dockable Table View that shows only the currently selected cases by choosing View →
Selected Cases.

It is possible to select multiple cases in the Matrix View. Try clicking the row or column headers
instead of just on the matrix cells, and also try holding down Control, Shift, or both while you click cells
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or headers. See if you can figure out:

1. The quickest way to select just columns 0.2, 1.2, and 1.8

Answer: Click the header for column 0.2, then hold down the Control key while clicking the headers
for columns 1.2 and 1.8.

2. The quickest way to select the last three rows.

Answer: Click the last row’s header, then hold Shift while clicking the third-to-last header.

Matrix View Properties

The Properties panel in the Tecplot Chorus sidebar lets you choose the options for the Matrix View.
You’ll probably find this at the left of the Tecplot Chorus workspace. If the Properties panel is not
already open, choose View → Properties to open it.

Each open view or plot has its own properties, even if the views are of the same type. If you have more
than one Matrix View open, for example, each Matrix View has its own properties, which are
completely independent of any other Matrix View’s properties.
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

Whither the Table View Properties?

We skipped over the properties for Table Views because there’s only one setting in it,
and it has to do with filtering, a topic we don’t cover in this lesson.

If you explore the Matrix View Properties for a few moments, you will discover:

• You can change the variable used for the rows and columns in the matrix. Try Mach No. against
Alpha, then Alpha against Beta.

• You can choose a third variable for paging. Since you’re now using Alpha and Beta for the rows and
columns, try choosing Mach No. as the paging variable, then flip among the pages using the slider
in the Properties panel.

• You can use the four dependent variables as rows, columns, and pages too! Usually this isn’t very
useful; most of the time there are many different discrete values of dependent variables in a
project, so you’d end up with a lot of rows or columns for that variable, making your images very
spread out and hard to work with. However, you might give "# Iterations" a try. Here it is with
Mach No.

Notice how some of the cells have a  badge on them? This badge indicates that there are multiple
cases that have the same value of the variables being represented as rows, columns, and pages, and
that more than one of these cases have associated images. Hover over a thumbnail with a badge
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and you’ll see how many images are "stacked" in that cell via tooltip. The highlighted cell in the
matrix represents seven images in total: the one whose thumbnail is shown, and six additional
images.

In our example project, all the cases have images, so these seven images correspond to seven cases.
Select the cell in the matrix and switch to the Table View (or open the Selected Cases view), and you
can see that all seven of these cases are in fact selected.

• The Show menu in the Properties panel shows only "Contour Image" as an option. Each case can
have multiple images associated with it, although our sample project has only one kind of image. If
there were multiple images associated with cases in the project, you could use this menu to choose
which images you wanted to see as thumbnails in the matrix.

To review: Tecplot Chorus chooses thumbnails based on the variables you’ve chosen for the rows,
columns, and optionally pages of the matrix. If multiple cases match these variables and have images,
Tecplot Chorus chooses a representative case for the actual thumbnail display. You can turn on labels
in the sidebar to see the value of unused variables, and you can use filtering to indirectly choose these
values. We won’t talk about filtering in detail this lesson, but you might want to give it a try in the
Filters sidebar.

Viewing Associated Images
Every thumbnail in the Matrix View represents one or more cases in your project—well, a case that
has one or more images associated with it. (Cases that don’t have images look just as blank as cases
that haven’t been run.) To view these images full-size from a Matrix View, follow this general
procedure.

1. Choose the type of image you want to view using the Show menu in the Properties sidebar. In our
example project, only Contour Image is available.

When your project has more than one type of image, you can view images of kinds other than that
displayed in the Matrix View, but switching the matrix to show the kind of image you’re interested
in will make it easier to find the cases that have those images.

2. Select the case or cases for which you want to view the associated images.

Don’t worry if you select some cases that don’t have an associated image (that is, cells that are
blank in the matrix). Tecplot Chorus will ignore these when you tell it to view images.

3. Click the right mouse button while pointing at a selected image and choose View Images. The
images appear in a separate window.
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The image window has its own Properties, just like any other view in Tecplot Chorus. You may want to
experiment with:

• Turning on labels to see the values of some or all of the variables associated with each case (the
image viewer window shown here already has labels turned on).

• Choosing a different type of image. There isn’t one in this project, but if there were, you could select
it using the Tag menu in the Properties sidebar.

• View all variable values for the selected case. They appear right in the sidebar when you click an
image.

• View difference images from a selected image. Just click an image to select it as the master (the
image that others will be compared to), then click Diff From Current. A new window opens with
the differences among the images.
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Congratulations! You now know how to view images, and differences among them, in any of Tecplot
Chorus’s views—because they all work the same way. Go back to the Table View that opened when you
opened the project (or open a new one), select a few rows, and right-click. From there, it’s the same.
Keep this in mind when we later visit the three types of plots available in Tecplot Chorus.

Viewing Associated Data
We’ve just seen how to view the image files associated with a case from a Matrix View. Cases may also
have one or more data files associated with them. In fact, if you are familiar with CFD workflows, you
already know that the image files are usually created from a solution data file, typically as a post-
processing step invoked by the solver or from a script. Tecplot Chorus can also create images from
your data files, though we won’t get into that in this lesson. For now we’ll focus on just viewing the
data files.

Tecplot Chorus uses Tecplot 360 to view data. Tecplot 360 can read data files in a wide variety of
common CFD solver output formats, create publication-ready plots and animations from them, and
perform additional analysis on the raw results.

When you invoke Tecplot 360 to open a data file associated with any case or cases in Tecplot Chorus,
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we call this a "deep dive." You have seen thumbnails and maybe a few larger images; this is the
"surface" of your project’s "ocean of data." By opening the actual data files associated with a case in
Tecplot 360, you go deeper: you can zoom in and rotate the plot, add contouring and axis labels, drop a
few slices, and so on, to get a real idea of what your data is telling you.

The procedure is almost identical to the one just described for viewing images. The only difference is
that you choose View Data instead of View Image after you click the right mouse button. Tecplot 360
launches, opens the selected data files (each in a separate frame), and gives you control.

When you’re in Tecplot 360, you’ll see an additional sidebar (shown docked on the right here) titled
Chorus that controls integration between the two products. The sidebar includes Tecplot Chorus
features that work inside Tecplot 360.

For example, you can compare data, just as you can compare images in Chorus. Just click the frame
that you want to compare the other frames to, click the Set Current Frame as Master button, then
activate the Show diff data checkbox.

Feel free to play around with the other features in the Chorus sidebar, but don’t invest too much time
in figuring out what they do, because we’re about to tell you:

• The View Page section lets you manage pages opened by Tecplot Chorus. Each time you tell Tecplot
Chorus to open data, the data is placed on a new page rather than opening a whole new instance of
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Tecplot 360.

• The Label Frames section lets you choose what variables appear in a label on the plots.

• The Save as Style Template button lets you save the style (appearance) of a plot in a separate file.
The style can then be applied automatically to other data files to generate new images, which you
then have access to in Tecplot Chorus.

• The Synchronize Styles button lets you copy the style (appearance) from the currently selected
frame to all the other frames.

Don’t worry if this doesn’t quite hang together just yet. This lesson is intended to familiarize you with
the basic Tecplot Chorus feature set, helping you understand when you’d use each feature and how to
get to it. We’ve roamed pretty far afield, taking you into Tecplot 360 with its own rich set of features.
The takeaway from this part of the lesson is just that the two applications, Tecplot Chorus and Tecplot
360, are tightly integrated and work together in harmony, one showing you the forest and the other
showing you the trees.

So spend a little time playing around if you like, then exit Tecplot 360 so we can get into the Tecplot
Chorus plots.

Plots
Enough with the tables and matrices. Let’s look at some eye candy. Tecplot Chorus offers three types of
plots, accessed using buttons on the toolbar or commands on the View menu.

 3D Scatter Plot

 2D Scatter Plot

 Line Plot

We’ll soon share a brief look at each type of plot. But first, familiarize yourself with these tools, which
we’ll use for manipulating our plots.

 Select

Lets you select individual cases or groups of cases in plots and other data views.

 Translate

Lets you move 3D plots within their window. For 2D and line plots, the axes stay in place while the
data moves (that is, the axes' ranges change).

 Rotate

Lets you rotate 3D plots. Not available for 2D or line plots.
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 Zoom

Lets you zoom in and out of plots.


You may also zoom plots when any tool is active by placing the mouse pointer in the
window to be zoomed and moving the mouse’s scroll wheel.

These controls work slightly differently in the various plots. See if you can discover the differences (or
check Chapter 1 of the Tecplot Chorus User’s Manual for the full description).

Choose View → Reset to return a plot to its default view.

3D Scatter Plot

The 3D Scatter Plot, arguably the snazziest plot in Tecplot Chorus, is accessed by clicking  on the
toolbar or by choosing View → New 3D Scatter Plot.
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Each sphere in the scatter plot represents a single case in your project. Since this is 3D, let’s have some

fun rotating it! Click the  Rotate icon in the Toolbar and then click and drag in the plot window.
Viewing your data from a new angle literally gives you a new perspective on it.

In the Properties sidebar, you’ll see many options for changing the appearance of your scatter plot.
(For now, ignore the options for under the heading Surrogate Model.) In particular, we’d like to draw
your attention to the following:

• You can choose the variables to be displayed on the X, Y, and Z axes. Commonly you will choose two
independent variables on the X and Y axes, and a dependent variable on the Z axis.

However, sometimes you might want to use other setups. Using a third independent variable can
reveal clustering of cases around a few parameter values. Using an informational variable (such as
date or staff member) on Z organizes your cases into layers, where all the cases on each layer were
run, for example, on the same date or by the same staff member. Using more than one dependent
variable can reveal correlations.

• You can change the range of each axis. The defaults show every value from the minimum to the
maximum value of the variable selected on the axis.

• You can have the color of each dot determined by a variable, which can be one of the variables on
the plot’s axes or a fourth variable. The lowest values of the variable are colored blue and the
highest are colored red, with a rainbow spectrum of values in between.

In our example project, coloring by Case ID shows us which cases were imported into Tecplot
Chorus first (they’re blue) and which were imported later (they’re red). Or you could color by #
Iterations, which will assign a color indicating how many iterations a case took to converge on a
solution.
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You can turn on a legend that shows the mappings of values to colors. Drag the legend around the
plot to position it wherever you like. Check out what happens when you move the legend to the top
or bottom of the plot! You may also choose the approximate number of steps in the legend.

• Just as you can choose to have the color of each case determined by a variable’s value, so too can
you have its size determined by a variable’s value. (You can also change the sphere to a square.)
Try using Beta and a scaling factor of 0.5. Then try cubes!

• You can also save a plot as an image by right-clicking. Give that a try too. Images are saved in
Portable Network Graphics (PNG) format.

Remember earlier when we mentioned that you can open multiple instances of any plot or view, each
with its own properties? Give that a try too: open two 3D Scatter Plots, rotate them differently, and give
each its own axis settings and visual look using the Properties panel.

It’s important to note that you can select cases in a scatter plot. So it’s not just a plot; it’s also another

way into the cases in your project! (All the Tecplot Chorus plots work this way.) Choose the 
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Select tool on the toolbar, then click a few of the spheres or cubes. Hold down Control while clicking to
select multiple cases, or drag out a rectangle around a group of cases that you want to select.



Synchronized Selections

If you have other views or plots open, you will see that the cases you select in the 3D
Scatter Plot are also selected in the other views. This is a Tecplot Chorus universal:
cases that are selected in one plot or view are selected in all plots or views. We won’t
mention it again, but it will continue to hold.

Once you’ve selected a case or six, click the right mouse button. You’ll see that you have the same
options here for viewing images or data that we talked about when we were discussing Matrix Views.
Go ahead and try them out, if you like, just to confirm that they work the same.

2D Scatter Plot

The 2D scatter plot is similar to the 3D one we’ve already described, just flatter. You only get to specify
variables for the X and Y axes, and of course you can determine the color and size of the scatter
symbols by a variable, if you like.

An interesting 2D Scatter Plot to make with our example project has Alpha and Lift Coef. on the X and Y
axes, respectively, and is colored using the # Iterations variable. Add a legend and position it out of the
way of the data. The resulting plot reveals that Alpha has a nearly linear positive effect on lift, and also
that most of the cases took 200-250 iterations for the solution to converge.
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Switch the X-Axis variable to Beta, and it is clear that Beta’s relationship to lift is more complicated.

23



Plotting one dependent variable against another can reveal correlations. Here’s a plot of lift vs. drag
(colored by Mach No.) revealing that at a given Mach No., lift and drag have a seemingly quadratic
positive relationship:
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As with the 3D Scatter Plot, you can select cases in your 2D Scatter Plot to view their images or data

using the  Select tool. Give it a try, clicking with and without the Control key and dragging
rectangles around cases. Then right-click and view the images or data associated with the selected
cases.

If you’ve been playing with the filters, and have set coloring to "Color by Filter Violations," you may see
shading on the plot. This visualizes the effect of the filters active for the axis variables. The individual
cases are colored according to how many filters they violate (see the legend for the details).
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Line and Symbol Plots

Tecplot Chorus’s Line Plot (  button or View → New Line Plot) is actually three plots in one,
because it can display a symbol for each case, lines connecting the cases, or both symbols and lines.

Although, on the surface, it has less "wow" factor than, say, the 3D Scatter Plot, the humble line plot is a
versatile tool for communicating results. Why not follow along and try to reproduce our plot? The
controls are not unlike the ones we’ve already seen for the other plots,. As with the 3D Scatter Plot, just
ignore the Surrogate Model section in the Properties panel for now.

In addition to the axes, you can also choose to use color and/or symbol shapes to represent up to two
additional variables. Using a variable for color or symbol causes each discrete value of that variable to
be drawn as its own line (if lines are active), using its own color or symbol shape respectively.
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Can you find the exact settings we used for that plot?

Answer: X-Axis: Mach No. Y-Axis: Lift Coef. Show Lines. Sort By: Mach No. Color: By Variable/Alpha.
Symbol: Shape/Circle. Symbol Size: 1.

As always, you can select cases and view images or data for them. By now, that should be old hat. We’ll
just note here that turning on symbols in a line plot is very handy for figuring out where the cases
actually are on otherwise smooth, featureless lines.

Sessions
We’ll end this lesson with the concept of sessions. A Tecplot Chorus session remembers which project
you were working with, the windows you had open, their positions and sizes on your desktop, and all
their settings in the Properties sidebar. It’s a convenient way to save where you are, either to always
begin your work in Tecplot Chorus in the same place (using the same session each time) or to return to
exactly where you left off (using a session file you saved the last time you quit). Like projects, recently-
used sessions appear on the Welcome Screen for convenient access.

You can find the commands to load and save Tecplot Chorus sessions on the File menu. Also, when you
quit Tecplot Chorus, you’re offered the option to save the session right then and there. Your mission:
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create a session file to record where you are right now, then exit Tecplot Chorus, relaunch it, and open
the session you saved.

What’s Next
We’ve shown you many of Tecplot Chorus’s major high-level features. Now would be a good time to
look at the Tecplot Chorus User’s Manual, if you haven’t already. It explains many Tecplot Chorus
concepts and user interface elements and will help tie together not only the tour you’ve already taken,
but the lessons to come in this Getting Started Guide.

Topics of particular interest include:

How to create projects and import data

This is how Tecplot Chorus knows what variables you’ve used and their values for each case. You
can also append new data as it becomes available—new cases, new variables, or both.

How to set up filters so you can easily find the cases you’re interested in

Filters also have relevance in Matrix Views and in Surrogate Models.

How to create new image files using existing data files

We touched on this capability in this tour (it’s part of the integration with Tecplot 360), but you’ll get
the step-by-step in an upcoming tutorial.

How to use a Surrogate Model

To approximate the results of simulations or experiments you haven’t run yet, helping to identify
outliers and regions of interest in your design space. We’ll also cover this topic in an upcoming
tutorial.

SO2 Plume Migration Study
Sulfur dioxide (SO2) gas emissions are the by-products of natural events like volcanic eruptions as well
as of a variety of man-made industrial processes. A precursor to acid rain and a serious air pollutant,
SO2 emissions can have significant negative effects on human health and the environment. As a result,
the United States Environmental Protection Agency (EPA) has developed a stringent set of industry
regulations regarding SO2 emissions in industrial manufacturing.

Computational Fluid Dynamics (CFD) has become a standard methodology for validating the design of
manufacturing facilities under a wide variety of circumstances. Engineers often use CFD to understand
whether the initial design for a manufacturing facility will meet EPA standards.

This tutorial demonstrates how engineers can use Tecplot Chorus to efficiently determine whether the
SO2 output of a proposed facility design falls within the EPA threshold for SO2 concentration. To satisfy
the EPA, SO2 concentration at certain distances from the outlet must be under mandated values.

Sixteen simulations were run for this study. Different combinations of winds and initial SO2
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concentration were examined to provide an initial assessment of the SO2 impact. For each study,
concentration was determined at multiple locations.

You will need the Plume data set for this exercise. You can download the Chorus Getting Started
Bundle.

This is a compressed ZIP file and you will need to extract the individual files before you can use it.

Anatomy of a CSV File
Every Tecplot Chorus project consists of metadata—data about each case you have run, which can
include the following broad categories of information:

• The input parameters (independent variables) used in each simulation.

• The values of the important outputs of the simulation (dependent variables): in this study, the
concentrations of SO2 at various locations.

• Informational fields to record info about each simulation, such as what solver was used, the
amount of CPU time used, and so forth.

• The names or paths of auxiliary data and/or image files created by the solver and/or post-processor,
to be opened when you explore individual cases.

The SO2 data set includes a CSV file, plume_input.csv, containing the metadata for this study. A CSV file
can be read using any text editor, such as Notepad—or by a spreadsheet program, which will make it
simpler to see the tabular nature of the data. Here we’re looking at it in Microsoft Excel, and have
widened the columns so we can see the full value of each element.

The first line of any CSV file is a header row indicating the name of each field (data item) stored in the
file, with each name separated by a comma. In input.csv, we can see there are twelve fields.

Standard CSV files have only one header row, but Tecplot Chorus accepts an optional second header
row to indicate the nature of each field: whether it is an input parameter ("Independent"), an output
value ("Dependent"), a strictly informational field ("Other"), or the relative or absolute path of a data or
image file associated with the case ("AuxFile"). The natures appear in the same order as the field names
in the first row.
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

If the CSV file does not contain a second header row, you can easily add one using a
text editor, or else specify the nature of each field in Tecplot Chorus when importing
the file. If you add your own header row, you must use the exact spellings
"Independent," "Dependent", "Other", and "AuxFile." Tecplot Chorus will not recognize
the second header row if it contains any text other than these four specific terms.

Matching each field’s name and nature in the first two rows, we can see we have:

• Three independent variables (also called inputs or parameters): South East (mph), North East
(mph), and Mass Fraction of SO2. These represent the speeds of the prevailing winds and the
concentration of SO2 at the outlet.

• Eight dependent variables (also called outputs or results): downwind 75, downwind 50, downwind
25, Elev 5, Elev 15, Elev 30, Elev 100, cross wind 0. These represent the simulated SO2

concentrations at various locations for each case.

• No informational variables ("Other" nature).

• A single auxiliary file field, FileName. If we peek at the last bit of text in each row, we will see that
every name ends with .plt, which means they are Tecplot-format binary data files.

After the header row(s), the CSV file contains a row for each case in the study. The values for each case
are in the order specified in the first header row. We have 18 total rows in the CSV file; discounting the
two header rows, this means we have sixteen cases, as promised.

Creating the Tecplot Chorus Project
A CSV file is a "flat" representation of a study’s inputs and results. The cases were probably written in
the order in which they were simulated, which may not be the order you want to use when working
with them. When you use the CSV to create a project in Tecplot Chorus, you are importing it to a
powerful relational database, giving you much more freedom and flexibility to view and analyze the
data.

Step 1: Launch Tecplot Chorus

First, launch the Tecplot Chorus application, for example by double-clicking the shortcut on the
Windows desktop that was created during installation. (Linux users should just be able to type chorus
in a terminal window.)

Step 2: Open CSV Project
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Choose Open CSV Project from the File menu in Tecplot Chorus. This is the simplest way to create a
new Tecplot Chorus project, and our CSV file is perfectly formatted to work with it.

If we needed to use delimiters other than commas, or we needed to specify variable natures because
our CSV file didn’t have a second header row, rest assured that Tecplot Chorus can deal with those
kinds of files too.

Step 3: Select Input File

Using the Select Delimited Text Metadata File dialog, choose the file plume_input.csv in the Plume folder
and click the Open button.

Tecplot Chorus creates a new project from the CSV file. The project’s database file, plume_input.chprj, is
created in the same folder as the CSV file and given the same base name. After creating the project file,
Tecplot Chorus automatically opens a Table View, as shown here.
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You can see all 16 cases and, with a little horizontal scrolling, all of the fields for each case. Note that
the FileName field is not displayed; instead, this field is used to link each case to its data file. It will be
used when opening the data files for individual cases.

Physics Visualization and Plot Image Creation
In this exercise, we will view the data for an individual case using Tecplot 360, and then create and use
a style template to generate images for all cases in the study automatically.

Step 1: Explore the Flow Solution

First, right-click the first case (Case ID 1) in the Table View, then choose View Data from the context
menu.
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The View Data dialog appears.

Click OK without changing anything in this dialog to view the case’s data. Tecplot 360 opens and
displays the data file.
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Step 2: Get a Better View

Now working in Tecplot 360, we’ll zoom and rotate the view to reveal two building structures with an
exhaust port on top.

First, let’s zoom in. You can do this using the  Zoom tool on the Tecplot 360 toolbar, but a quicker
way is to hold the Control key on the keyboard, hold down the middle button or wheel on your mouse,
and drag the mouse up and down to zoom in or out around the center of the plot. Zoom in so you can
see the buildings, as shown below (your result needn’t be exactly like this).
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Now let’s rotate the plot so the buildings are right-side-up and we can easily see the exhaust port. Place
the mouse pointer in between these two boxes (don’t click!) and press the O key on your keyboard to
set the center of rotation. Now, when we rotate the plot, it will rotate around that point. This will help
keep our image on the screen instead of being rotated off of it.

Tecplot 360 has several tools for rotation on its toolbar. The  Rollerball rotation tool is most
commonly used, so it has a shortcut: simply hold the Control key on the keyboard, hold the right mouse
button down, and move the mouse. (If you have a 3D mouse attached to your computer, you can also
use that.)

As you rotate, you may find that the buildings are no longer centered (or may even be partially off the
screen) and you need to move the plot. You can do this using the  Translate (a.k.a. Move) tool on the
toolbar. Again, this is such a frequently-used tool, there’s a shortcut for it: simply click and hold the
right mouse button and drag the plot to where you want it.

By zooming, rotating, and translating the plot, you should be able to get the Y axis pointing straight up
and the rest of the plot oriented approximately as shown below.
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

If you’re having trouble getting the rotation square, try using the constrained  
rotation tools on the toolbar to rotate around one axis at a time.

In general, though, your use of Tecplot 360 will feel more fluid if you learn to use the
mouse shortcuts for rotation, zoom, and translation, as these will save you many trips
to the toolbar. To recap, these are:

• Translate: Drag with right mouse button

• Rotate (rollerball): Hold Control key while dragging with right mouse button

• Zoom: Hold Control key while dragging with middle mouse button (wheel)

As you rotate the plot, you will see a dot on top of the smaller building. That’s the exhaust port, visible
in the above screen shot.
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Step 3: Add a Slice Through the Port Showing SO2 Concentration

We’ll now add a slice right through the air above the exhaust port to show the concentration of SO2

along a plane.

First, activate the Slices checkbox in the Derived Objects section of the Tecplot 360 Plot sidebar, as
shown here.

The slice appears in the plot, initially contour-colored by pressure.

Next, click the  Slice button next to the Slices checkbox to activate the Slice tool. Then drag the slice
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so it goes through the exhaust port .



It isn’t necessary to be exact with the slice position, but if you’re the type who prefers
to be precise, we can tell you that the exhaust port is at X = -10. So if you like, you can
open the Slice Details dialog (using the Details button next to the Slices checkbox in
the Plot sidebar) and enter -10 in the slice position field.

Now, open the Contour & Multi-Coloring Details dialog by choosing Contour/Multi-Coloring from the
Plot menu.
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In this dialog, use the menu at the top to set the variable to so2. (Leave the dialog open.) The plot
should now look something like this:
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Let’s zoom in and reposition the plot, using the same tools we used before, to focus more on the
exhaust port and to avoid clutter behind the legend. Your plot should now be in this ballpark:
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Finally, use the  Add Contour Level tool in the toolbar to add additional contour levels near the port.
This will increase the number of contour levels you can differentiate. Just click a few places to the left
of the port to see how the tool adds contour levels. (The new contour levels are also visible in the
Contour & Multi-Coloring Details dialog.)

Your plot should look something like this:
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You can now close the Contour & Multi-Coloring Details dialog.

Using a Style Template
In this exercise, we’ll create a style template and explore the ways it can be used in Tecplot Chorus.

Step 1: Save a Style Template
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A style template is a Tecplot 360 instruction file that records the visual appearance of a plot, but
contains none of its data. This will allow us to easily make plots for the other cases in the study, all with
the same general appearance.

To save a style template, just click the Save Style Template button in the Chorus sidebar at the right of
the plot. Then use the Write Style File dialog to specify a name for the file (for example, "XSlice") and
save it.



By default, the style template is saved in the stylesheets folder inside the chorus-
derived folder in the project root folder. Style templates saved in this folder appear in
a drop-down menu in various Tecplot Chorus dialogs, so you have convenient access
to them without browsing.

Step 2: Compare Multiple Cases

We can use the style template we just created to help us compare multiple cases. When we open the
data files, we have the opportunity to specify the style template, which will then be applied to each
data file as it is opened in Tecplot 360.

Leave the Tecplot 360 window open, but bring the Tecplot Chorus window back to the front and
highlight case ID 15 in the Table View. Right-click and again choose View Data using the context menu.

The View Data dialog appears. Click the XSlice.sty template from the drop-down menu, then click OK.
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Tecplot 360 now opens case 15 in a new page and applies the style template. You will see both cases
listed in the View Page section of the Tecplot Chorus sidebar and can easily flip between them.

Let’s add a label to the plots showing the input variables, so it is easier to see which case we’re viewing.
To do this, select the South East (mph), North East (mph), and Mass Fraction of SO2 variables in the
Label Frames section of the Tecplot Chorus sidebar.

The resulting plot looks like this:
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Step 3: Display Multiple Plots

When you open cases one at a time from Tecplot Chorus, each appears on its own page in Tecplot 360.
When you open multiple cases at once, they all appear on the same Tecplot 360 page.

To see this in action, return to Tecplot Chorus and select the first three cases in the Table View. Then
right-click them and choose View Data as before. In the View Data dialog, make sure the style template
you created is still active, then click OK.

The following plot appears in Tecplot 360. Each case you selected in Chorus is in its own frame.
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Try zooming and panning (translating) the view of any frame using the  Zoom and  Translate
tools. You’ll see that all frames zoom and move together.

However, any style changes you make in one frame (for example, changing the contour coloring) are
not applied to the other frames, because you may want to make style changes in order to highlight
aspects of a particular plot. If you want to apply your style changes to all frames, click Synchronize
Styles in the Tecplot Chorus sidebar (within Tecplot 360) after making the changes. This function
copies the style from the active frame to all frames.

Step 4: Display Data Differences

Tecplot Chorus can show you, visually, the differences between a master case and additional cases you
are viewing.

 This function only works when the cases being compared have the same mesh.

To create a data difference plot, first click in the frame you wish to designate as the master and click
the Set Current Frame as Master button at the bottom of the Tecplot Chorus sidebar (inside Tecplot
360).

Try it now, designating the middle frame of the three as the master frame. After choosing the master,
you can then activate the Show Diff Data checkbox.

Tecplot 360 displays an additional frame below the non-master frames with the differences between
those frames and the master, as seen here.
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The values of all data in the difference frames are the result of subtracting their data from the master
frame’s data, creating a new variable. Since the values of this variable will likely have very different
values from the originals, you may wish to choose a different color map for the difference frames.

Tecplot 360 includes diverging color maps that are one color in the middle and shades of two other
colors toward the extremes. This allows you to easily color, for example, areas that are the same white,
areas where the difference is positive red, and areas where the difference is negative blue.

To use one of these color maps:

• Click the slice in a difference frame to ensure that the difference variable is selected.

• Open the Contour & Multi-Color Details dialog from the Tecplot 360 Plot menu.

• Choose, for example, the Diverging - Blue/Red color map from the menu below the color strip.
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Leave the Contour & Multi-Color Details dialog open.

• We need to adjust the contour range and make sure zero is at the middle, so that values that are the
same between the compared frames appear white in the difference plot. To do this:

◦ Click the Set Levels button in the Contour & Multi-Color Details dialog.

The Enter Contour Levels dialog appears.
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◦ Make sure the Exact Levels and Min, Max, and Number of Levels radio buttons are set.

◦ Enter a Minimum Level of -0.003, Maximum Level of 0.003, and specify 15 levels.

◦ Click OK. The dialog closes and the new contour levels are created and visible in the Contour &
Multi-Color Details dialog.

◦ You may now close the Contour & Multi-Color Details dialog.

• Click Synchronize Styles in the Tecplot Chorus sidebar. Since a new variable was created for the
difference data, this affects only the appearance of the slice in the difference frames.

The resulting plot may look like this:
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Step 5: Generate Images

You can also generate images using your saved style template, essentially pre-rendering a particular
view of the data for some or all of the cases in the study.

Especially when working with large data sets, viewing an image you have already created from the
data can be much faster than opening the data itself. And you can also use the images as thumbnails to
organize and access the cases visually using Tecplot Chorus’s Matrix View.

Let’s go ahead and generate images for all our cases using the XSlice style template. To do this,
highlight all cases in the Tecplot Chorus Table View (there’s a handy keyboard shortcut: Control-A for
Select All). Then right-click and choose Create Images.
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The Create Images dialog appears. In this dialog, make sure XStyle is selected as the style template and
click OK.

Tecplot Chorus instructs Tecplot 360 to load each data file, apply the style template, and save a PNG
image file. This happens in the background, and you can continue using either product while the
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operation is underway. When all the images have been generated, a green dot in the Manage Jobs
button at the bottom of the Tecplot Chorus window indicates that the background job is complete and
the results may be deposited.

When you click Manage Jobs, the Manage Jobs dialog appears.

In the Manage Jobs dialog, you can select any background job whose status is Ready, then click Deposit,
to add the images to your project. The Append Data wizard appears, asking us how we want the new
images tagged.
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In this case we have modified the default tag FileName-XSlice (a name generated from the fact that the
data file is tagged FileName based on the column name of the original CSV file, and the style template
applied was XSlice) to just be XSlice. We don’t have more than one data file for each of our cases, so
including it in the tag is redundant. Click Next to proceed to the final screen of the Append Data
wizard, then click Finish to complete the deposit operation.

Step 6: Explore More Styles

Additional style templates are included in this tutorial’s download. These include:

• BaseSliceSO2.sty

• Pressure_top_3meter_offset.sty

• stream_close.sty

• stream_far.sty

Give them a shot with the View Data or Create Images functions.

Using Images to Explore Your Study
Now that we have generated an image for each case in our study, we can use those images in Tecplot
Chorus, first in the Matrix view and then by viewing and comparing selected images.
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Step 1: Open Matrix View

The Matrix View is a grid of images where the meaning of rows and the columns is based on the

metadata variables in the project. To open a Matrix View, click  on the Tecplot Chorus toolbar, or
choose New Matrix View from the View menu. An example is shown below.



The Properties sidebar controls how the Matrix View is organized. Now is a good time
to mention that this sidebar, like all sidebars in Tecplot Chorus, can be docked to any
side of the workspace, combined with another sidebar—either splitting the space with
the other sidebar or sharing space using a tab—or even dragged out of the window
entirely, perhaps to another display.

In this example, we’ve put the South East wind speed variable on rows and the North East wind speed
variable on columns. Each image in each row represents one or more cases having a particular value
for South East (mph), and similarly for columns and North East (mph). If there are no cases having
certain values for these variables, blank cells appear in the matrix.

A zoom slider is available at the bottom right of the Matrix View so you can decide how many cases
you want to see at a time, or conversely, how much detail you want to see.

54



A small  badge appears on each image here because there are multiple images having the indicated
values (but with differing values of the third independent variable in our study). Change Page By to
Mass Fraction of SO2, and the Matrix View instead will have a separate page for each value of this
variable, which you can choose using the slider in the sidebar. This provides you a way to flip through
the available values of a simulation input and see the impact it has on your results in an animated
fashion. Try it out!

Also cast an eye on the Selected Image Values section of the sidebar as you click various cells of the
Matrix.

You can learn much more about the Matrix View in the Tecplot Chorus User’s Manual. For now, change
Page By back to None to return to the view we started with.

Step 2: View Selected Images

Right-click the top-left image in the Matrix View and choose View Images. The Selected Image View
appears, showing you all the images that were "stacked" in that cell of the matrix because they share
the same values of the row and column variables (that is, they all have both South East (mph) of 5 and
North East (mph) of 5, but different values of Mass Fraction of SO2).
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You can also select multiple cells in the Matrix Viewer to view all the images that those cells contain, or
select cases in the List View, to view the images associated with those cases. You can open any number
of Selected Image View windows, each with images from different cases (and other settings).

Every image in the Selected Image View represents one case. You can see the variable values for the
selected case in the sidebar just as with the Matrix View. Again, you can read more about this view in
the Tecplot Chorus User’s Manual.

Step 3: Compare Images

When the Selected Image View is open, you can select an image to designate it as the master, then click
the Diff From Current button in the Properties sidebar to display difference images. Here, we’ve
selected the first image in the Selected Image View we opened in the last step as the master.

The image difference window is similar to the data difference display we previously saw, only it works
with the rendered images rather than the raw data. It is not as accurate as comparing the actual data,
nor as interactive, but it is much faster given that the images already exist, and it can give you a quick
idea of what areas of your data are changing from case to case. You can then investigate these
differences further by comparing the actual data of selected cases.

Extracting New Integrated Quantities
Your solver may not have calculated every value you are interested in. Rather than fully re-run all
your cases to get the results you need, you might use the Tecplot 360 CFD analysis tools to calculate
them. By recording the operation as a Tecplot 360 macro, you can have Tecplot Chorus apply it to every
case and add the new value to your Tecplot Chorus project as a new dependent variable. This
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technique can be used with any operation that sets an auxiliary data value on the individual data sets.

Let’s give it a try, integrating SO2 concentration over a surface—specifically, the ground—and adding
that to our Tecplot Chorus project.


Why integrate over the ground? Sulfur dioxide is heavier than air and has a pungent
odor similar to that of a just-struck match. We want to minimize SO2 concentration at
ground level so our facility doesn’t stink up the neighborhood!

Step 1: Create the Macro

Return to Tecplot Chorus, select any case in the Table View, right-click, and choose View Data from the
context menu. Choose None for the Style Template in the View Data dialog, then click OK. The case’s
data file opens in Tecplot 360. Now you’re ready to record a macro of the integration. To do this:

• Choose Record Macro from the Scripting menu in Tecplot 360. The Write Macro File dialog
appears to let you name the macro and choose the folder where it is saved.

• Save the macro in the macrotemplates folder inside the tecplot-derived folder in your project folder,
and name it groundSO2.mcr.


Saving the macro in the macrotemplates folder will cause it to appear in the drop-down
menu, similar to the way the styletemplates folder works. This way, when you later
apply the macro, you won’t have to remember where you saved it.

• From the Tecplot 360 Analyze menu, choose Perform Integration. The Integrate dialog appears.
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• Set up the dialog as shown above, particularly the variable (which should be 15, so2) and the zone
(which should be 11, ground). Then click Integrate.


The integration results are added to the frame’s auxiliary data, where Tecplot Chorus
can pick them up. (They are also displayed in a dialog just for your information; this
dialog won’t appear when we run the macro against all our cases.)

• Close the two integration dialogs and click Stop Recording in the Macro Recorder dialog.

Now you’re ready to apply that macro to all our cases and import the result into the project.

Step 2: Extract Variables

Return to the Tecplot Chorus application, select all cases in the Table View (keyboard shortcut: Control-
A), right-click, and choose Extract Variables from the context menu. The Extract Variables dialog
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appears.

Choose the groundSO2.mcr macro file you just created from the Macro drop-down menu, then click OK.

Tecplot Chorus schedules the extraction as a background job, much as when we generated images for
all our cases. You can go on using Tecplot Chorus and/or Tecplot 360 while it finishes. When a green dot
appears in the Manage Jobs button at the bottom of the Tecplot Chorus workspace, click it, then select
the Extract Variables job and click Deposit. The Append Data dialog appears.

This dialog displays all the auxiliary data values available for each individual case. We only want one,
so we’ll turn off the rest.

• Click the checkbox at the top of the column of checkboxes to turn off all the checkboxes.

• Click the checkbox next to CFDA.INTEGRATION_TOTAL to turn it on.
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We want to use a more specific name for our new variable within Tecplot Chorus, so in the Display
Name column, we’ll enter GroundSO2.

Now simply click the Finish button. You can now see that the new variable is visible in the Table View
of your project.

Exploring The New Variable Using a Surrogate Model
To get an idea of how our new extracted GroundSO2 quantity might behave, we can create a surrogate
model. A surrogate model is a numeric approximation of the physical model underlying your
simulation that can be useful in predicting the results of cases you haven’t yet run as well as in
identifying outliers or, for optimization studies, areas of interest in a design space. In situations like the
one in this tutorial, where there are relatively few cases, the surrogate model can also help you get a
feel for the "shape" of the data (that is, what kind of relationship might exist between the inputs and
the outputs of the simulation).

You can read much more about surrogate models in the Tecplot Chorus User’s Manual.

We will create a surrogate model using a 3D scatter plot of GroundSO2 against the northeast wind
speed and the Mass Fraction of SO2. This will show us what kind of relationship the dependent
variable we just calculated has with these two independent variables.

60



Step 1: Create a 3D Scatter Plot

The 3D Scatter Plot lets you view up to three dependent variables (typically one main variable and one
or two less important ones) against two independent variables. To set up our scatter plot:

•
Choose 3D Scatter Plot from the Tecplot Chorus View menu or click the  button in the
toolbar.

• In the Properties Sidebar, choose the following axis variables:

◦ X: North East (mph)

◦ Y: Mass Fraction of SO2

◦ Z: GroundSO2

• Choose Color By Variable: GroundSO2

Leave the other settings at their defaults and ignore the Surrogate Model settings for now.

The plot should look something like this:
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Click the  Rotate tool in the toolbar and drag around in the 3D Scatter Plot window to change the
viewing angle. You can get a sense of its depth, but since the data is so sparse it’s hard to understand
what its shape might be. That’s where a surrogate model can help.

Step 2: Train the Surrogate Model

With the 3D Scatter Plot window active, click the Training button in the Surrogate Model section of the
Properties sidebar. The Surrogate Model Training dialog appears.
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In this dialog, you tell Tecplot Chorus which type of surrogate model you want (we will use a Quadratic
Response Surface) and which independent variables you would like the model to include (in this case,
the two independent variables we are using as axes in the plot).

• Click the Quadratic Response Surface radio button.

• Select all three of the available independent variables and click Add.

Since there are just sixteen cases, it takes only a second to train the model. It will take longer in studies
where there are more cases and/or more variables to consider.

Step 3: Show the Surrogate Model
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In the Surrogate Model section of the Properties sidebar, click the Show checkbox to reveal the
surrogate model. The surrogate model appears on the plot as a translucent, light blue surface, as
shown here.

Take note of the R2 value displayed in the sidebar. This value, which is quite close to 1, indicates an
extremely good fit.
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Step 4: Set the Evaluation Point for Non-Plot Variables

The North East (mph) and Mass Fraction of SO2 variables of each case shown on the plot are inputs to
our surrogate models. But our third dependent variable, South East (mph), is not used on our plot.
What value of this variable is used in the Surrogate Model in this case? We can determine this by
setting the evaluation point.

Right-click one of the points on the plot and choose Set Surrogate Model Evaluation Point. The
Surrogate Model Evaluation Point dialog appears.

This dialog lets us set a value for each independent variable, which will be used when that variable is
not being used on the plot. In this case only South East (mph) is not being used on the current plot, so
only changes to that variable will affect the surrogate model. Move the slider and see how the
surrogate model moves in response, then put it back down to the minimum value and close the dialog.

Step 5: Inspect the Model’s Output

Using the rotate tool, have a look at the plot from different angles. What can we tell about the likely
physical behavior of our facility based on the surrogate model?

• The relationship between Mass Fraction of SO2 looks and GroundSO2 pretty linear, as you would
expect. The more SO2 is emitted, the more SO2 ends up on the ground.

• There is a slightly non-linear inverse relationship between the wind speed and the amount of SO2

on the ground. The harder the wind is blowing, the less accumulates near the ground in the vicinity
of our facility.

These results seem reasonable and match our expectations.
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Step 6: Find and Analyze Outliers

Change the Z-axis to the variable downwind 25 (which represents the SO2 concentration at a sampling
point 25 yards downwind). Notice anything unusual? You may have to rotate the plot to see it.

We could expect all the cases to exhibit a near-linear relationship between both input variables and
the downwind concentration of SO2, and this is borne out by the nearly flat surrogate model surface.
However, that one point is an outlier.

Let’s have a look at that case in Tecplot 360.

• Right-click the wayward dot in the 3D Scatter Plot. (Cases are selectable in all Tecplot Chorus views,
including plots.)

• Choose View Data from the context menu. The View Data dialog appears.
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• Choose None for Macro and XSlice.sty for the Style Template.

• Click OK to open the case in Tecplot 360.

Try seeding some streamtraces around the slice plane, creating a new style template with the
streamtraces.

• Click the  tool button next to the Streamtraces checkbox in the Plot sidebar.

• Drag a line out on the slice to seed simulated massless particles along this line. Tecplot 360 draws
streamlines to illustrate the flow of these particles.

Save a new style template and create new images for all the cases to help reveal what’s different about
this case. Except for the streamtraces, you’ve done all of that before in this tutorial.

Step 7: Eliminate Outliers
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You may decide that this specific case is not representative and decide to exclude the outlier from the
study. Right-click the offending dot in the 3D Scatter Plot, then choose Mark as Inactive from the
context menu. The renegade will disappear from all plots and will no longer be considered by the
surrogate model.

You can still find the case in the Table View, where a new column called Case Status has been created
and the case (number 14) has been marked Inactive.
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You can tick the Use Filters checkbox in the Table View’s Properties sidebar to hide the inactive case
even in the Table View, or use the Case Status filter at the bottom of the Filters sidebar to show the case
in all views even though it’s inactive.

For more information on filters, see the Tecplot Chorus User’s Manual.

Next Steps
The first tutorial took us on a grand tour of the product, and we’ve touched fewer parts of Tecplot
Chorus this time… but they’re the parts you will use when working on real projects like the SO2 Plume
Migration study.

With a better understanding of how to use the Tecplot Chorus tools for real work, you can be more
effective on your next study, whether you have sixteen cases or sixteen hundred. Now’s a great time to
import some cases from a study of your own and try these techniques on data you’re familiar with.

 

Electronic Actuator Optimization
This short tutorial revolves around optimizing the design of an electronic actuator used in an aircraft.
The goals of the design are:

• Produce sufficient force, although more is better, if this can be attained

• Minimize weight and cost, which implies minimizing the amount of wire used, copper being both
heavy and expensive

• Stay under a magnetic leakage limit to avoid the need to shield nearby components

In this tutorial, you will use scatter plots to visualize the results of the study and to find the designs
that meet the constraints.

The data set for this tutorial contains metadata for 864 cases. It does not include data files for the
individual cases, but rather PNG images that show the simulation results. You can download the
Chorus Getting Started Bundle.
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Inside The Data Set
This project is provided as a CSV (comma-separated value) file, actuator_input.csv.

Step 1: Explore in Excel

Let’s open the CSV in Microsoft Excel and see what we’ve got.

Above we see just a small part of the data set (the full CSV file contains 866 rows in total). Looking at
the first and second rows, we see they are the normal CSV file header bearing the name of each field,
and the optional Tecplot Chorus-specific header indicating the nature of each field, leaving 864 rows
representing the cases in the study. From the header rows, we can tell we have:

• Three independent variables, Z, Y, and X, representing design parameters of the actuator. What
these values actually mean isn’t important to this tutorial, but when we start looking at the images
for our cases, their meanings will become clear.

• Six dependent variables calculated by the simulation: the force generated by the actuator, the
volume of the actuator’s armature and of the two metals (copper and steel) used in the actuator’s
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construction, the actuator’s magnetic leakage, and its total weight.

• An auxiliary file with the tag contours, which is a PNG image.

Step 2: Open in Tecplot Chorus

Now launch Tecplot Chorus and open the project. Open the provided CSV file in Tecplot Chorus by
choosing Open CSV Project from the File menu. A corresponding .chprj (Chorus Project) file is created
in the same directory as the .csv file. The .chprj file will be updated as you add new data to the project,
so you should open it instead of the .csv file in the future.

Tecplot Chorus opens the Table View of the data.

You can see that the project contains the 864 cases we found in the CSV file, with all of the independent
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and dependent variables. Only the contours column, which contains the name of each case’s linked
image, isn’t shown in the table; Tecplot Chorus uses it internally when viewing images. We can also see
that a Case ID has been assigned to each case.

Step 3: Understanding Design Parameters

Tecplot Chorus’s Matrix View can help us visually understand what the independent variables
represent and get a feel for how the inputs to the simulation might be affecting the results. Open a

Matrix View from the Tecplot Chorus View menu or by clicking the  Matrix View button on the
toolbar.

Next, set up the Matrix View using the Properties panel, which is docked to the left side of the Tecplot
Chorus workspace by default.

• Set Rows to Y

• Set Columns to Z

• Set Page By to X
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Using the Zoom slider at the lower right corner of the Matrix View, adjust the size of the individual
thumbnails so you can see twenty or so cases.

Use the Page By slider to flip through the values of X in the project. As you move the slider, the
thumbnails in the Matrix View change. This flipbook-style animation should make it immediately clear
that the independent variable X represents the width of the actuator.

Scrolling vertically or horizontally will similarly show you how Y and Z affect the design. Y is the
height of the actuator. An increase in Z correlates with an increase in the strength of the magnetic
field, which means Z is the depth or thickness of the actuator’s design: it fits with what we know about
X and Y, and also fits with Z’s effect on the dependent variables.

You may also notice a trend of color changes in the thumbnails as the independent variables change.
Looks like there’s a legend on the images; let’s take a look! Right-click any thumbnail and choose View
Images from the context menu. The Selected Image View window appears with the image from the
selected case. Adjust the Zoom slider in this window so you can get a good look at the legend.

From the legend, we can see that red is associated with the strongest magnetic fields. So, generally
speaking, the more red you see in an image, the stronger the magnetic field of that design. With that
knowledge, you can close the Selected Image View window and flip through the thumbnails in the

73



Matrix View to get a quick sense of how strong a magnetic field is generated by each actuator design
and how each input variable affects this characteristic.

Finally, observe that we can see nine rows of eight cases, or 72 cases in total, in each page of the Matrix
View. Dividing the total number of cases in the project, 864, by 72 gives us a nice round 12, which
strongly implies that we have a case for every combination of the discrete values of all of our
parameters: this is not a "sparse" project; there are no "missing" or unsimulated cases.

So set the zoom so you can see all 72 cases in each page, then flip through X using the Page By slider.
You can quickly and easily verify that all cases have a thumbnail and that there are twelve discrete
values of X used in the study.


You could also switch rows or columns to show X (set the Page By variable to None)
and count the discrete values of X that way.

We’ve learned an awful lot about our data set just using the Matrix View! But we can’t find out which
cases satisfy our design goals using this view alone.

Visualize Constraints
Constraint visualization lets us use filters to see which cases in our study meet our criteria for a
successful design. To get started, open a 2D Scatter Plot from the Tecplot Chorus View menu, or by

clicking the  2D Scatter plot button in the toolbar.

In the Properties sidebar, set the X Axis to Weight, the Y Axis to Fy, and choose Color by Filter
Violations in the Coloring section. The initial plot should look like this.
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

In the above screen capture, we’ve docked the Filters sidebar on the right side of the
workspace. We’ll be using it extensively and it’s often convenient to have access to
both Properties and Filters. Any sidebar panel can be docked to any side of the
workspace or dragged out of the main Tecplot Chorus window entirely—for example,
to a second display.

Every dot in this plot represents a case in the study. You can select cases in the study and even open
their images by right-clicking, just like you can in the Table View, the Matrix View, and in fact every
view in Tecplot Chorus. A case selected in one view is selected in every view.

To see the values associated with one or more cases, just select them. The Selected Cases panel at the
bottom of the workspace shows you the variables for just those cases. (If this panel isn’t already open,
you can open it from the View menu.) Aside from showing only the selected cases, it works just like the
Table View.

The shaded areas in the plot represent the areas outside the constraints we’ve added using the Filters
sidebar. We haven’t defined these constraints yet, so every study in the plot is outside the shaded areas
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(or, in the unconstrained white area) and all the individual dots are green. (Selected cases are dark
green.)

We are interested mainly in filtering on our dependent variables, since our intent is to determine
which designs meet our target criteria. To make the Filters panel easier to manage, let’s hide the other
variables. Click the gear icon at the top of the Filters sidebar and choose Select Filters to Include from
the drop-down menu. The Select Filters to Include dialog appears.

In this dialog, turn off the Independent and Other groups, then click OK. The Filters sidebar now only
shows the filters for dependent variables.

Now we set the filters to whittle away the cases that don’t meet our criteria. First, set the Weight filter
to show only cases between 0 and 1.95, the maximum weight we’re allowed. Next, set the Force to
display cases only 22 or above, and finally set Leakage to be less than 0.01. The desired Filter settings
can be seen below.
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Below you can see the results of these filters on our 2D Scatter Plot.
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Most of the cases in our study are now in the shaded area, indicating that most of our designs are too
heavy, don’t produce enough force, or have too much magnetic leakage. The red dots represent cases
that violate more than one of these rules; the blue cases violate only one.)

The lower right corner of the white region is our area of interest. Do any of these designs work for our
criteria? It’s hard to see if there are any green dots—which represent cases in which all criteria are
satisfied—in there. Let’s zoom in to get a better look:

•
Choose the  Zoom tool in the Tecplot Chorus toolbar.

• Drag a tight rectangle around the region of interest in our 2D Scatter Plot. Include a small part of
the shaded area so we can see where the boundary between "acceptable" and "unacceptable" lies.
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Zoomed in, it’s easy to see that there are a few green dots that represent cases that could work for us.
Four, to be exact, assuming the one right on the weight limit is acceptable.

Copper is expensive, so let’s add another filter to require that the volume of the copper used in our
design must be less than 3.5. That rules out one case: the topmost case in the white region, formerly
green, is now blue. Additionally, a number of formerly blue cases have turned red, indicating that they
violate our copper constraint.
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There are three cases that look like they will work for us. Select all the green dots:

•
Choose the  Select tool from the Tecplot Chorus toolbar.

• Click one of the green dots in the 2D Scatter Plot.

• Hold the Control key while clicking the second and third dots.

Then right-click and choose View Images from the context menu. The Selected Image View window
appears with the three acceptable actuator designs.
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Which image is which case? Let’s add labels. In the Properties sidebar, click the Select Labels button to
open the Label Images dialog.

In this dialog, let’s turn on Case ID, Z, Y, X, Fy, and Weight.
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Click OK to close the Label Images dialog, then turn on the Show Labels checkbox in the Properties
sidebar. The labels appear in the Selected Images View window below each case.

These are the three designs that can work. We’ll include all of them in our report.

But one, indicated below, is arguably superior to the others.
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This design produces good force for its weight—well in excess of what we need—and weighs less than
the alternatives. It also leaves us a little "wiggle room," since it isn’t right at any of our limits. The only
other design that produces more force is exactly at our weight limit, and if our constraints were to
tighten due to other design choices in the aircraft, it would probably be the first to go out of spec.

So we’ll recommend the indicated design. Right-click it and choose View Images. Zoom in and turn on
the labels.
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That’s the one! If we had the data file for this case, we could open it in Tecplot 360 and produce a
detailed publication-quality plot.

Next Steps
In the past three tutorials, you’ve explored most of Tecplot Chorus’s major features.

• Table View and Matrix View

• 2D Scatter, 3D Scatter, and Line/Symbol plots
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• The Selected Items panel

• Filters and constraint visualization

• Visualizing and comparing the data from individual cases

• Viewing and comparing images

• Style templates and image generation

• Extraction of new metadata values

• Surrogate models

You’re now ready to use Tecplot Chorus with your own projects… and Master the View!
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derived from this software without specific prior written per- mission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. The University of Tennessee. All Rights Reserved. SciPy 2001-2009 Enthought. Inc. All Rights
Reserved. NumPy 2005 NumPy Developers. All Rights Reserved. VisTools and VdmTools 1992-2009 Visual Kinematics, Inc. All Rights Reserved. NCSA HDF & HDF5 (Hierarchical Data
Format) Software Library and Utilities Contributors: National Center for Supercomputing Applications (NCSA) at the University of Illinois, Fortner Software, Unidata Program Center
(netCDF), The Independent JPEG Group (JPEG), Jean-loup Gailly and Mark Adler (gzip), and Digital Equipment Corporation (DEC). Conditions of Redistribution: 1. Redistributions of
source code must retain the above copyright notice, this list of conditions, and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions, and the following disclaimer in the documentation and/or materials provided with the distribution. 3. In addition, redistributions of modified forms of
the source or binary code must carry prominent notices stating that the original code was changed and the date of the change. 4. All publications or advertising materials
mentioning features or use of this software are asked, but not required, to acknowledge that it was developed by The HDF Group and by the National Center for Supercomputing
Applications at the University of Illinois at Urbana-Champaign and credit the contributors. 5. Neither the name of The HDF Group, the name of the University, nor the name of any
Contributor may be used to endorse or promote products derived from this software without specific prior written permission from the University, THG, or the Contributor,
respectively. DISCLAIMER: THIS SOFTWARE IS PROVIDED BY THE HDF GROUP (THG) AND THE CONTRIBUTORS "AS IS" WITH NO WARRANTY OF ANY KIND, EITHER EXPRESSED OR
IMPLIED. In no event shall THG or the Contributors be liable for any damages suffered by the users arising out of the use of this software, even if advised of the pos- sibility of such
damage. Copyright © 1998-2006 The Board of Trustees of the University of Illinois, Copyright © 2006-2008 The HDF Group (THG). All Rights Reserved. PNG Reference Library
Copyright © 1995, 1996 Guy Eric Schalnat, Group 42, Inc., Copy- right © 1996, 1997 Andreas Dilger, Copyright © 1998, 1999 Glenn Randers-Pehrson. All Rights Reserved. Tcl 1989-
1994 The Regents of the University of California. Copyright © 1994 The Australian National University. Copyright © 1994-1998 Sun Microsystems, Inc. Copyright © 1998-1999
Scriptics Corporation. All Rights Reserved. bmptopnm 1992 David W. Sanderson. All Rights Reserved. Netpbm 1988 Jef Poskanzer. All Rights Reserved. Mesa 1999-2003 Brian Paul. All
Rights Reserved. W3C IPR 1995-1998 World Wide Web Consortium, (Massachusetts Institute of Technology, Institut National de Recherche en Informatique et en Automatique, Keio
University). All Rights Reserved. Ppmtopict 1990 Ken Yap. All Rights Reserved. JPEG 1991-1998 Thomas G. Lane. All Rights Reserved. Dirent API for Microsoft Visual Studio (dirent.h)
2006-2006 Copyright © 2006 Toni Ronkko. Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the
Software, and to permit persons to whom the Software is furnished to do so. Toni Ronkko. All Rights Reserved. ICU 1995-2009 Copyright © 1995-2009 International Business
Machines Corporation and others. All rights reserved. Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation
files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the
Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the
Software and that both the above copyright notice(s) and this permission notice appear in supporting documentation. International Business Machines Corporation and others. All
Rights Reserved. QsLog 2010 Copyright © 2010, Razvan Petru. All rights reserved. QsLog Copyright © 2010, Razvan Petru. All rights reserved. Redistribution and use in source and
binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in
the documentation and/or other materials provided with the distribution. The name of the contributors may not be used to endorse or promote products derived from this software
without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABI- LITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUEN- TIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. Razvan Petru. All Rights Reserved. VTK 1993-2008 Copyright © 1993-2008 Ken Martin, Will Schroeder, Bill Lorenson. All rights
reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source
code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list
of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither name of Ken Martin, Will Schroeder, or Bill
Lorensen nor the names of any contributors may be used to endorse or promote products derived from this software without spe- cific prior written permission. THIS SOFTWARE IS
PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHORS OR CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSE- QUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
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SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABIL- ITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. Ken
Martin, Will Schroeder, Bill Lorenson. All Rights Reserved.
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countries. Courier is a registered trademark or trademark of Monotype Imaging Incorporated in the U.S. and/or other countries. UNIX and Motif are registered trademarks or
trademarks of The Open Group in the U.S. and/or other countries. Qt is a reg- istered trademark or trademark of Digia PLC in the U.S. and/or other countries. Zlib is a registered
trademark or trademark of Jean-loup Gailly and Mark Adler in the U.S. and/or other countries. OpenGL is a registered trademark or trademark of Silicon Graphics, Incorporated in
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